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GEOLocate 101: A Tutorial 

 

This tutorial was developed by the Milwaukee Public Museum Collections & Research digitization 

and natural history departments for internal use as training instructions for the embedded 

GEOLocate client in EMu Version 6.0.  Please see the Bibliography for citations regarding 

additional images and content referenced within this tutorial.   
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Hello. 
This tutorial will complement your training instruction in using the EMu GEOLocate client to 

georeference sites.  Depending on your level of experience with EMu in general or the GEOLocate tab 

in the Sites Module in particular, you may wish to review the whole guide or select the sections based 

on the type of sites you are georeferencing.  You should also have access to copies of the 

georeferencing documents referenced within this guide and are encouraged to review them in 

preparation for and throughout your training. 

 

...If you’re acquainted with GEOLocate and need a Quick Start checklist of georeferencing steps, 

required fields, and data standards, go to Page 48.  

...If you’re new to EMu and need some help navigating the modules and tabs, please ask to review the 

EMu Basics tutorial.  

...To learn how to navigate GEOLocate Features, including the panes and buttons, go to Page 6. 

...If you’d like to begin Georeferencing a Site with GEOLocate, start on Page 12 to review examples. 
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Getting Started in EMu 
Retrieving Your List 

 
When georeferencing sites in EMu you will either have a list of sites provided to 

you by a Collection Manager or georeference sites in the course of specimen 

record data entry.  If you are inserting or amending a sites record in the course of 

data entry, follow the Search and New Record guidelines discussed in your 

department’s data entry training.  If you are working from a list in the Sites 

Module, follow the instructions below.   

 

1. Log into EMu (make sure you logged in under the correct group for the 

sites you will be working with) and open the sites module. 

 

 

 

2. Retrieve the list that has been assigned to you—see the Collection Manager  if you do not know which list 

to work on: 

 

 Click on the Tools menu, and then select Retrieve. 

 A new window will pop up with a list (yours will have a different title than the example below): 

 

 Click on the list, and then click on Retrieve. (You can also double click on the list.)  Click No when 

prompted for a summary. 
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 Your results will be returned in a list: 

 

3. Organize the list by choosing a list view: 

 

 Go to the View tab and select Choose.  Select IRN Summary Data Mapping: 
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 Then sort your list by flipping to the Tools menu and selecting Sort AZ: 

 

 Choose your list; for example, if you are working with Zoology sites records, select the TRSQ 

Summary list.  (If you need to create a custom Sort, see the Collection Manager for help.) 

 

 

 

 

 

 

 

   Click OK and No when you receive the prompt for a summary of the sort terms.  Your list will 

be sorted based on the criteria set in your Sort. 

4. To open an individual record, click on it. 

Go to the GEOLocate tab (it helps to have the window maximized): 

  

When reviewing the list, note which sites have longitude and latitude coordinates at the end of the summary 

data.  These are records that have already been georeferenced, and can be sorted to the bottom of your list.  

Note any sites that have the PLSS/TRSQ (Township, Range, & Section) data, as you will need to refer to this 

information when georeferencing sites for some departments.  

 

Georeferenced 

site record 

PLSS Coordinates 



Milwaukee Public Museum DRAFT April 2020  
6 

GEOLocate Features 
 

GEOLocate has a number of features you may find useful in the course of georeferencing sites.  You are 

encouraged to use this section to explore the tabs and buttons in the module. 

 

To review an iDigBio video tutorial, go to: https://vimeo.com/showcase/2163673/video/65222791  

 

 

When you click on the GEOLocate tab after selecting a site to edit, you will see a two pane window: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Map Pane 

Data Pane 

https://vimeo.com/showcase/2163673/video/65222791
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Map Pane Features 
 

 
 

1. Map View: Up arrow= move view north, down arrow=move view south, etc.  You may also click on the 

map and drag the map to adjust your view. 

 

2. Zoom: Click + or – to zoom in or out.  Click the globe to see the entire map of earth. 

 

3. Most likely result:   If GEOLocate is able to generate results from the locality data, it will place the 

results on the map.  The green dot is the highest ranking result; this is what the program thinks is the 

most likely location.   

 

4. Uncertainty circle (Outlined in black.): The area of this circle should contain all possible alternate places 

the specimen could have been collected. How big/small the area is will depend on the specificity of the 

locality data. 

 

5. Error polygon (Outlined in light orange.): GEOLocate will set an uncertainty polygon for the smallest 

named place in the locality data if it has defined borders.  This can include states, cities, natural areas 

and parks, etc.  The Uncertainty Circle should include the entire polygon. 

 

6. Secondary Result(s):   Other possible results (locations) based on the locality string data.  

 

7. Maximize/ minimize map: This button will maximize your map to fill the full pane.  The data pane will 

float on top of the map.  In full frame, this button will minimize the map to fill the default pane. 

 

8. Base layer map & overlay options: This is a convenient feature that allows you to toggle through 

different types of base maps (Google Hybrid is a default.) The default overlay settings include the 

uncertainty circle, error polygon, results, and most accurate result. 

1. Map view  

2.  Zoom 

3. GEOLocate’s 

Best Guess 

5. Error polygon 

6. Secondary result 

4. Uncertainty circle 

 

7. Maximize/ 

minimize map 

8. Base 

layer map & 

overlay 

options 
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If you click on the  button on the right, the map overlay list (blue box to 

the right) will appear.  Feel free to toggle through base layer options to find 

one that seems comfortable.  Depending on the Locality data, switching 

map layers will help you with georeferencing.  The ESRI USGS Topo maps, 

for instance, are very useful when georeferencing using PLSS unit 

boundaries as they have township, range, and section boundaries marked, 

plus geographic features that may not be named on the Google maps. 

 

 

 

 

 

 

 

 

 

 
 

 

PLSS Unit 

Boundaries 

Click to 

minimize after 

selecting your 

map 
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Note: Error polygon coordinates are not saved to EMu, but error polygons can be a useful tool for helping set 

your uncertainty.  If you are creating or editing an error polygon, the uncertainty area should include the entire 

polygon.  If you do not see the option to “Edit uncertainty,” go to the Georeferencing options box discussed 

below and make sure the “Do Uncertainty” box is checked. 

Data Pane Features 

 Workbench Tab 

The Workbench tab contains the locality data as well as tools to adjust the location results in the map. 

 

 

1. Georeference: If you edit the locality data, 

press this button to generate new results. 

 

2. Options/Georeferencing Options: Click to 

access options for how the program 

calculates results.  The collection manager 

will indicate if you should change from the 

defaults.  

 

3. Clear Polygon: Click to remove the error polygon. 

1

. 

2

. 

3

. 

4

. 

5

. 

6

. 

 

 

7  

 

8    

9

. 

When you click on a dot, you can see both the 

coordinate details and also have the option to 

resize the uncertainty directly, or to 

automatically resize the uncertainty to include 

the error polygon.  

To edit the uncertainty, click “Edit 

uncertainty” and drag the arrow/handle to 

resize the circle. 
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4. Draw Polygon: Click to create a polygon. Each click of the mouse will create a new vertex (corner) of 

your polygon, allowing you to trace irregular shapes such as water bodies or natural areas. 

 

5. Place Marker: Click to place the marker on a location other than one of the results marked on the map. 

 

6. Measure: While GEOLocate is capable of interpreting locality 

strings that include information like “3 miles north of Cassville,” 

you also have the ability to check the results by using the 

measuring tool.  When you click the button, you can draw a 

line to measure distances on the map: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Locality Data: This data includes the Locality String, Country, State, and County.  Other relevant 

information, such as township, range, and section information is on the Mapping tab. 

 

8. Coordinate Field and Check Boxes: The coordinate field is a tab delimited field showing the details of 

the highest ranked result/final result. Info for each checked box is shown in the field and will be passed 

to EMu; use check boxes to control the detail in the field. 

 

9. Save To Your Application: When you have finished georeferencing the site on the map, click this button 

to save the reference to the site record.  Please note: the polygon vertices DO NOT save to the EMu site 

record. 

Results Tab 

 

To access the results tab, click on the “possible locations” ribbon:  

 

 

Place the white box at your 

starting point, click, and then 

draw the line to measure the 

distance (km/mi displayed in 

green). Click once to create a 

polygon; click twice to pin the 

measurement in place. To 

remove the measurement from 

the map, double click the 

Measure radio button. 
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The locations will be listed in order from most to least probable: 

 

NOTE: Eliminating results from this list can help de-clutter your map, but only the primary (green) point’s 

coordinates are saved to the application.  Removing secondary points is entirely optional, and while worth 

reviewing if the primary is not correct, you do not need to clean up this list to georeference a site.  After you 

save the site you’ve selected to the application, that site will appear as a white star within a yellow circle      

both in the list of locations and on the map. 

 

 

 

 

 

 

 

 

 

Click  to remove 

individual points.  

Click to remove secondary points from the map.  

Click the   next to a result to choose a 

different result for your primary result.   
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Georeferencing a Site with 
GEOLocate 

 

Introduction to Point-Radius Georeferencing 
 

The Point-Radius method of georeferencing is the typical means of locating 

a site.  Based on the description in the locality string, a point is placed at 

GEOLocate’s best guess for the most probable site, and then a radius is 

drawn out from that point to create an uncertainty circle that will include the possible other areas where the 

specimen(s) could have been collected.  The size of the circle is determined by how confident we are that the 

point we set is where the specimen was collected, based on the locality string and general standards for 

determining the extent of features.  You will discover that location descriptions that might seem pretty clear 

and easy to locate might be comparatively imprecise when compared to more involved descriptions with more 

pieces to parse. 

 

When creating the uncertainty circle, you will want to include the boundaries of whatever geographic feature it 

names (unless there is further information that would eliminate a portion of it (e.g. “the west shore of Pine 

Lake”).  Your job is to evaluate the options GEOLocate provides and accept or edit a result provided by 

GEOLocate, or create a new point-radius if necessary.  

 

There are two steps to georeferencing a site: finding/defining the site location, and determining the 

extent of the uncertainty.   

1. To find or define the site location, you will need to decide which type of locality information 

you are working with.  Locality information generally makes use of features in a landscape to 

define where a specimen was collected.  A feature may be human made or natural, and have 

formal or informal boundaries that may be naturally or administratively defined.  For example, a 

city is human made and its extent can be described on a map through administrative definitions 

(the city limits) and/or its proximity to natural geographic features (the shore of a lake or river).  

The three most common types of sites you will find described in locality strings are:  

 

 Named Places—Natural and man-made features in the landscape such as lakes, mountains, 

towns, roads, parks, etc with proper names,  OR places defined by the locality description 

(e.g. the junction of two rivers, a township in the PLSS grid system, etc).  See Feature, Feature 

Name, and Named Place in the Glossary for more details. 

 

 Paths— a locality that is a linear feature, e.g. a road, trail, boundary, river, or contour line. 

 

 Offset* — a displacement from a reference point, named place, or other feature. Offset is 

used here as the distance from a named place using the location of the named place as the 

starting point, and is usually used in conjunction with a heading (N, S, E, W, etc) to give a 

distance and direction from a named place. 

 

Point  

 Radius  
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* Term definition adapted from “Guide to Best Practices for Georeferencing.”  See Bibliography for full citation. 

 

In the table below are some examples of locality strings and the type of location they are describing: 

Locality String Type of Location Explanation 

Milwaukee, Union Cemetery. Named Place A defined location within the city limits of 
Milwaukee, WI. 

Wauwatosa, Parkway where Honey 
Creek joins the Menomonee River, 
near North 72nd Street north of West 
Wisconsin Avenue. 

Named Place The junction of three linear features. 

Bordering Rio Grande near El Paso. Path/ Linear Feature A section of river near a named place.  

Minnesota, St. Louis, Duluth, Near 

College of St. Scholastica on Highway 

No. 4 

Path/ Linear Feature A section of road near a named place 
(College of St. Scholastica) within the city 
limits of another named place (Duluth, 
MN). 

Kenosha County, Shore of Lake 
Michigan 

Path/ Linear Feature The section of shoreline within the 
confines of county borders. 

Oak Creek, W of, above mtn creek, in 
mesquite prairie on hills. 

Offset A feature (mesquite prairie on hills), west of 
a named place (Oak Creek), above an 
unnamed feature (mtn creek). 

Iola, 15 mi S of Offset Area 15 miles south of a named place (Iola). 

Hawaii Volcanoes National Park. 
Crater Rim Trail, along the edge of 
Kilauea Caldera between Field Center 
and Volcano House. 

Offset A section of a linear feature defined by 
three named places within the main feature 
(Hawaii Volcanoes National Park.) 

 

You should note in the examples above that sometimes locality strings may reference a single site (like a town, 

lake, etc), or else they can combine multiple types of sites to describe where a specimen was collected.  An 

example of this is “One mile southwest of Pretty Lake; one mile west of County ZC after ZC turns west from Hwy 

106. Lutz Farm.”  This is a string that combines named places, linear features, and offsets to describe the location 

of a named place, Lutz Farm.  If “Lutz Farm” no longer appears on a map, you can still use the additional 

information to set a point in the vicinity of where the farm was. 

2. Obviously, not all sites will have well-defined boundaries, but many of them will, which will make it 

relatively easy to determine the extent of the uncertainty.  The table on the next page summarizes 

some common circumstances you will encounter and describe how large your uncertainty radius should 

be.  A full list of other scenarios—including interpreting offsets, intersections, verbatim latitude & 

longitude—can be found in the copy of Georeferencing Quick Reference Guide 

(http://www.herpnet.org/herpnet/documents/GeoreferencingQuickGuide.pdf).  See the Digitization or 

Collection Manager if you need a copy. 

http://www.herpnet.org/herpnet/documents/GeoreferencingQuickGuide.pdf
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Common Circumstances 

Situation Finding the Point Extent  Notes 

Named Place 
w/Defined Area (e.g. 
“Milwaukee,” “Lake 
Minnetonka,” “Isle 
Royale,” etc) 

Look at the boundaries 
of the area; GEOLocate 
will usually create a 
polygon around the 
borders and place the 
point in the geographic 
center of the space, or 
the nearest point within 
the borders. 

The radius should extend far 
enough that the entire circle 
contains all borders for the feature. 

If GEOLocate does 
not generate a 
polygon on the 
borders of the 
feature, use the maps 
to determine as best 
you can the 
boundaries of the 
place. 

Named Place w/ 
Undefined Area (e.g. 
“Walbecker Bog,”  
“Cuidad Victoria and 
vicinity”) 

As near the center of 
named place as can be 
determined using a 
map. 

Radius = ½ the distance between 
the point and the nearest named 
place (as the crow flies.) 

 

Street Address You will probably have 
to use Google Earth. 
Put the point in the 
middle of the property, 
as near as you can 
figure. 

Make the radius as big as you can 
ascertain the property to be. 

These should always 
be checked; 
GEOLocate tends to 
put them in the 
middle of the lake. * 

Distance from a city 
(ordinal direction) 
E.g. 5km south of Eagle 

Measure 5 km from the 
center of the named 
place.  

Radius = ½ of the distance between 
the point you placed and the 
nearest named place. If the nearest 
named place is Eagle, the radius 
would be half of 5km; 2.5 km or 
2500m. If another named place was 
nearer than Eagle, you would use 
that named place. 

Exception: if the 
string includes a 
second named place, 
like “Pike Lake 5km 
south of Eagle.” (see 
Named Place)  

Distance Along Road 
(e.g. Route 95, 5 km S 
of Townsville) 

Put the point at the 
measured distance 
along the road. 

Radius= ½ the distance between 
the point and the place named in 
the point. 

 

Path/Linear Feature 
(e.g. road, river, 
contour, trail) 

Point should be placed 
halfway between the 
beginning and end of 
the path, or if only a 
section of the whole is 
named, the halfway 
point of that section. 

Extent should include the whole or 
the section of the feature noted in 
the description. 

 

 

*If you find GEOLocate is erroneously placing terrestrial points in the center of water bodies, try unchecking 

Match Water Body in Options (see page 5 for more about the Data Pane’s Georeferencing options) and click 

Georeference to generate a new set of results (this box will remain unchecked until you check it again). 

 

If after reviewing the table and the Georeferencing Quick Reference Guide you aren’t sure how to set the 

uncertainty circle, see the Collection or Digitization Manager for help. 
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Example Sites 
 

Most of the time, you will go through the following steps to georeference sites: 

1. When you’ve opened EMu, go to the Sites module. 

2. In Sites, open your list of sites (Tools>Retrieve) to georeference and sort the list (View >Choose> 

IRN Summary Data Mapping (or whatever sort you prefer)). 

3. Select the first site to georeference; if it has PLSS mapping data, note it down or go to the Mapping 

tab and record the TRSQ details. 

4. Go to the GEOLocate tab.  Review the results. 

5. Refine the results; if there is PLSS unit data, redraw the polygon if useful.  You may remove the 

polygon if it is not necessary for your site. 

6. Make sure the uncertainty circle is sized appropriately. 

7. When you have the location and uncertainty circle placed, click Save to Your Application. 

8. Go to the Lat/Long tab.  Fill in the following information: 

 Determination Source: GEOLocate 

 Determination Method: Caywood, A. et al. 2020. GEOLocate 101: A 

tutorial. Milwaukee Public Museum. 51 pp. 

 Determined By: Your Name 

 Date: Today’s Date (short cut: “Ctrl ;”) 

 Datum:  WGS84 

 Preferred: Yes 

 Units: Meters 

(For subsequent records, use F9 to duplicate the fields.) 

9. If necessary, add details about your decision on the Notes-Attrib tab. 

10. When complete, Save the record. 

11. Continue georeferencing until your session is complete. 

12. Exit EMu. 

13. Log off or shut down your computer. 

 

Steps 4-8 are reviewed in the following examples, which illustrate three types of site locations: Named 

Places/Features, Linear Features, and Offsets.  A fourth example will show how to use an error polygon to help 

set your uncertainty radius.   

There may be exceptions to this flow, such as for sites that cannot be georeferenced with confidence or for 

sites that require you to make assumptions interpreting the locality.  Step 9 is where you would make note of 

these exception and is discussed in the section on Attributed Notes and When NOT to Georeference following 

these examples (page 31). 
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Example 1: Named Places/Features 

 

 

 

 

 

 

In this first example (shown below using the Mapping Tab), the PLSS Township/Range details only include the 

Township and Range—a roughly 36 mile square portion of Wisconsin.  The locality string provides better detail for 

mapping the site. 

 

 

 

PLSS/TSRQ Details 

Map layer=  

ESRI USGS Topo USA 

Locality String 

(Step 4) When you switch to the 

GEOLocate tab, two results are 

generated. You can review the 

results in the Results Tab to see if a 

secondary result is a better option 

or de-clutter your map by removing 

secondary points, but removing 

extra points is not necessary.  You 

just need to be sure the primary 

point is correct (Steps 5 &6). 
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Little Rock Lake 

Woodruff 

If needed, you 

can double check 

the distance in 

the Locality 

string using the 

Measure tool. 

 

While the PLSS mapping will 

not help you reduce 

uncertainty in this case, you 

should also confirm that the 

location falls in the Township 

and Range listed in mapping.  

If it does not, contact the 

Collection Manager to see if 

you should still georeference 

the site. 

When you zoom 

in, you can see 

the Little Rock 

Lake and 

Woodruff, the 

two features 

mentioned in the 

Locality String. 
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Step 8. Jump to the Lat/Long tab, and make sure that your changes have been saved. Fill in/verify the 

following details: 

Emu Field Value Type of field 

Determination Source GEOLocate Autofilled 

Determination 
Method 

Caywood, A. et al. 2020. GEOLocate 101: A 
tutorial. Milwaukee Public Museum. 51 pp. 

Autofilled 

Determined By Your Name Type it in! 

Date Today’s date Either CTRL+ ; OR use the calendar  

Datum WGS84 Autofilled 

Preferred Yes Drop down list 

Units Meters Autofilled 

 

If you zoom in, 

you can see the 

borders of the 

lake are within 

the uncertainty 

area. 

 

(Step 7) Since this 

seems appropriate 

for the site, we will 

save the 

coordinates by 

clicking Save To 

Your Application. 
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Steps 9-10: After georeferencing a site, the final two steps in the process include adding notes to the 

Notes- Attrib tab and saving the record.  When and how to make notes will be discussed following 

these examples, but to Save your notes and the georeferenced site, go to the Home tab in the Tools 

ribbon and press the Save Record icon: 

 

  

Note: After the first time you fill in these values, you can press the F9 key in each field to ditto the values on 

subsequent records. 
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Example 2: Paths and Linear Features 

 

 

 

 

 

 

 

Map layer=  

ESRI World Topo 

With path or linear features, such as a river, trail, road, or contour, you 

should include the entire feature within the bounds of the uncertainty 

circle.  The point should be set on the feature. In this example, we are 

locating something that was collected “along Logan Creek.” 

 

While you can certainly draw a 

polygon to contain the entire 

feature and use that to set the 

uncertainty, you may also place 

the marker near the geographic 

center of the feature (the mean 

between extremes of latitude 

and longitude) and set the 

uncertainty to include the 

head/source and the mouth of 

the creek.  Because many linear 

features won’t cross the 

geographic center of their 

longitudinal and latitudinal 

mean, you will need to select 

the point of the feature closest 

and set the marker there.  To do 

this: draw a line between the 

two points of the feature most 

removed from each other.  

Place the point on the part of 

the feature closest to the 

midpoint. 

 

Be sure to refine your results by zooming in; as you can see above, zooming from 1km/1 mi to 

500m/1000ft shows that the marker is not on the feature, but just below.  

 

Zoom=500m/1000ft 

Zoom=1km/1mi 

Source 

Mouth 

Zoom Tool 
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Note: While this example demonstrates what to do if the only locality data available is a named linear feature, 

generally these features will have other locality data (county, city, or offset details) that will help you narrow the 

uncertainty to a smaller area.   In these cases, instead of using the beginning and end of the feature to 

determine extent, you would only need to include the feature within the borders of the city, county, etc. to set 

an appropriate area of uncertainty. 

 

7. Once you are finished georeferencing the site, click the Save to your Application button at the bottom of the 

screen.  

8. Jump to the Lat/Long tab, and make sure that your changes have been saved. Fill in/verify the details for 

the Determination Source & Method, Determined By, Date, Preferred, Datum, and Units. 

9. Add any Notes necessary. 

10. Save your record. 

 

Adjust the placement of the point, zoom out, and adjust the uncertainty if necessary.  

 

Zoom=50m/100ft 

When your adjustments are done, you are ready to save the site. 

Click the green dot to get 

the “Edit uncertainty” 

option.  You can drag the 

handle to the beginning and 

end points to fine-tune your 

uncertainty. 
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Example 3: Offsets 

You will only occasionally come across a locality string that is limited to offest data.  Typically, you will find 

there are one or more Names Places or features, and occasionally multiple offset details; all these details will 

help you triangulate a probable location.  Bear in mind GEOLocate will likely pick one of the Named Places in 

the locality string as its most probable location and you will have to reset the point. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this example, there are two offsets in the locality 

information; “One mile southwest of Pretty Lake” and 

“One mile west of County ZC after ZC turns west from 

Hwy 106.”  The Named Place at the end, “Lutz Farm” 

may or may not appear on a map—in this case it does 

not, so we must use the offsets to guide us. 

 

On the GEOLocate tab, the top 

result is Pretty Lake; the point, 

polygon, and uncertainty radius 

are set to this feature.  However, 

you can also see (in the ESRI Topo 

Map) other features named in the 

locality string: HWY 106 (top 

arrow) and County CZ (bottom 

arrow).  You will use Pretty Lake 

and these roads to find the site. 
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Since “One mile southwest of Pretty Lake” (from the 

center of the lake?  From the shoreline? ) is slightly 

more ambiguous than “one mile west of County ZC 

after County ZC turns west from Hwy 106” (it gives 

us a junction point), we will measure one mile west of 

Hwy 106 by selecting the Measure tool, clicking on 

the junction of the two roads and measuring west. 

 

Start here and drag the 

line west (to the left.) 

Now we can check and see if Pretty Lake is about a mile from the point we set.  For this we 

need to bear two things in mind:  

 The  measuring tool is cumulative, so the measurement will reflect the mile we just 

marked, plus the additional distance from the point. 

 We don’t know precisely where on Pretty Lake they were measuring from, so we will draw 

a line that runs northeast from the point and see what the tool indicates. 

Click once to set a point. 

The distance from the end 

of our first line to Pretty 

Lake is about a mile (2-1=1 

mile,) so we should reset 

the point at the end of our 

first line.   
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Should you wish to 

remove the polygon, click 

the “Clear polygon” button 

in the Workbench.    

As you drag the handle, the uncertainty radius 

will update, helping you set an appropriate 

distance.  Zooming in closer will give you more 

nuance when setting the uncertainty.       

Reset the point by dragging the green dot into the 

correct position, then right click to pin the new 

point.   

Once the point is set, resize the uncertainty.  Our 

uncertainty should cover half the distance 

between our point and the places named.  Since 

we are a mile away from both named places, out 

uncertainty should be ½ a mile (~805m).  Grab the 

arrow handle and drag it out to ½ a mile. 
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When you are satisfied you’ve set 

the point and the uncertainty  

radius appropriately, click Save to 

Your Application. 

Got to the Lat/Long tab and, as in the other examples, be sure the 

correct data is entered in the fields indicated above.  Once done, 

add any Notes necessary and Save your record. 
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Example 4: Using the Error Polygons 

 
When GEOLocate georeferences a site, it will provide an error polygon for those areas that have defined boundaries 

(e.g. towns, state parks, etc).  If the site GEOLocate suggested is not suitable or needs refinement, you may need to 

place your own marker on the map and adjust the uncertainty area. You may need to use other resources (Wikipedia, 

Google Maps, etc, or the notes on the site itself) to locate the point.  

Because the polygon vertices are not saved to the EMu Sites record, you should consider the Error Polygon Method a 

tool for refining uncertainty circles, not a permanent addition to the EMu site record. In this example, we will use 

PLSS data from the Mapping tab in Sites to refine the error polygon provided and reset point and the uncertainty. 

 

 

 

 

Refer to the Mapping tab to get the Public Land Survey System unit coordinates. Note them down for reference.  

(Ex: Township=3N; Range=6W; Section=13 or T3N/ R6W/ S13).  This data can help refine your uncertainty area. 

 



 
27 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you zoom in (you can use the map buttons or the scroll wheel on your mouse) you can see the PLSS unit 

boundaries on the map.   

 

The USGS maps are composite images from scanned maps, so the map may look different as you zoom in/out, or 

certain sections may vary in color intensity.  The Section boundaries are in red with their numbers in red at the 

center of the section, and the Townships and Ranges are written along their borders (but not always consistently; 

it may require some searching). 

Section numbers 

(may appear twice in 

the grid boxes due to 

the digital map image 

being a composite of 

multiple analog maps) 

Range  

Because the error polygon and the uncertainty overlays both darken the map, you may find the map easier to 

read if you turn off the uncertainty while you examine the map to draw the error polygon.  You can turn off the 

display of these items by clicking on the  at the top right corner of the map. 
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When we checked the mapping tab, the following information was recorded: T3N/ R6W/ S13.  The error polygon 

below traced the borders of Nelson Dewey State Park, but includes the portions of the park that are in other 

sections.  We will need to draw the polygon to include only section 13 (S13). 

By using the mapping and the 

locality data, we can narrow the 

error polygon to just this section. Section Numbers 

To draw a polygon, first click the “Clear Polygon” button and then click the “Draw Polygon” radio button. 
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When you are back to the first corner, double click 

to close the polygon.  You will see the polygon 

highlighted in orange.  If you don’t see the polygon, 

check the map overlays to make certain the Error 

Polygon is checked. 

When done, use the cursor to move the green dot to an area in the geographic center of the polygon.  To 

do this: find the halfway point between the most extreme (furthest away) points of the polygon   The 

mean of those values combined will be the midpoint.  If the center is outside the polygon, adjust so the 

green dot is within the boundaries you have drawn.  

Place the cursor over your first corner, then click 

to begin tracing the polygon.  Each click will 

produce a new vertex (corner.) 

Extreme of both 

north and west 

Extreme of both 

south and east 
Midpoint 
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7. Once you are finished georeferencing a site, click “Save to your application” button at the bottom of the 

screen.  

8. Jump to the “Lat/Long” tab, and make sure that your changes have been saved.  Add/confirm the details: 

 
9.  If necessary, add an Attributed Note. 

10.  Save the record, and choose the next one from the list. 

When the dialog bubble pops up, 

click to “Resize uncertainty to 

polygon.” If you don’t see the 

uncertainty circle, check the map 

overlays to make certain the 

Uncertainty Circle is checked. 
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Attributed Notes and When NOT to Georeference 

 
While many sites will not require the use of any maps other than GEOLocate to georeference the site, it may be 

necessary to consult other resources (see Appendix B. Georeferencing Resources for recommended sites).  If you 

use another resource as a reference, made an assumption or inference about the intended location described, or 

if you cannot georeference a site, you will need to go to the Notes-Attrib tab and add a note (this is Step 9).  If 

you cannot determine the precise location of a named feature because the place name has changed, no longer 

exists, etc, but you do have other mapping coordinates or data that can be georeferenced, go ahead and 

georeference the site based on the information you can locate.  Please leave a note detailing on what 

coordinates you based your georeference, and any additional information that might help with further research 

(sources checked, etc).  If the precise location conflicts with the other mapping data, please follow the 

instructions for inaccurate or conflicting localities below. 

You should not georeference a site if it is: 

 Too General/Nonspecific: Only a state, province, or a country is listed, or the locality details are 

a regional description rather than a specific site-e.g. “SE Arizona,” “south rim of Grand Canyon.” 

 Dubious: When the verbatim or precise locality is “probably *location+”, “*Location?+.”   

 Inaccurate/conflicting: The location given cannot be correct- e.g. the location you are given does 

not actually occur in the larger geographic region given. 

 Unable to Determine Location: After researching the site, you cannot find the location.  The 

location given may have been renamed, no longer exist, it does not show up on any map, etc, and 

there are no other coordinates or data to make a more general reference.  Your Collection 

Manager will give you a range for how long to research a site before moving on, but if it’s been 

longer than 20 minutes, add an attributed note and move on. 

If you cannot georeference a site or had an issue georeferencing, please add a note on the Attributed Notes tab 

(Notes-Attrib) and fill in the following fields: 

Emu Field Value Type of field 

Note Details should be in sentence format with appropriate punctuation.  
Clearly describe any inferences you made, additional resources you 
used, or why you were unable to georeference the site. (See next table 
for standard Note comments.) 

Text field.  

Kind Mapping Remarks Look up list 

Attributed To Your Name Type it in! 

Date Today’s date Either CTRL+ ; OR 
use the calendar  

Metadata Yes Radio Button 

 

 



Milwaukee Public Museum DRAFT April 2020  
32 

Please use the formatted sentences below to begin your notes on the sites: 

Note Reason Sentence Format 

Inference Made Inference made regarding site locality; *describe what you’ve assumed and 
why.] 

Cannot Determine Precise 
Locality 

Could not determine precise locality. Georeference based on “*coordinates 
or other data+.”  [Provide any details that may be helpful for future 
research.] 

Additional Resources Used Additional resources used to georeference site: [list resources.] 

Dubious Site Locality Dubious locality description; could not georeference site. 

Inaccurate/ Conflicting Site 
Locality 

Inaccurate/ conflicting locality description; could not georeference site. 
[Follow with explanation of conflict or inaccuracy.] 

Nonspecific Locality Locality description is not specific enough to georeference site.  [You do not 
need to add a Note for states, provinces, or countries.]   

Unable to Determine Unable to determine location; may require further research.  [Provide any 
details that may be helpful for future research.] 

Please refer to the screen shot below: 

 

9. If necessary, add an 

Attributed Note. 

10. As always, when you have 

completed work on a record, 

Save the record, and choose the 

next one from the list. 

 
 



Milwaukee Public Museum DRAFT April 2020  
33 

Appendix A: Why We Georeference  
 

 

If you already have a location in the database, do you really need the map data, too? 

Yes!  While we strive to keep our data as standardized as possible, some verbatim descriptions for where a 

specimen was collected don’t fit into a neat category.  For example, “Where Pine Creek meets Spruce River, 

near Cty Rd N” is very specific, but unlike your street address, requires interpretation to find it on a map.  

Mapping this data gives each specimen a point of origin on a map, which helps give scientists and researchers a 

more accurate understanding of the distribution of the specimens in our collection.  This data, combined with 

specimen data from other collections, help us understand where these organisms lived over time.   

 

These coordinates are important because while place names and geopolitical borders may change over time, 

and different types of map projections may be subject to distortion, the coordinate systems used are relatively 

durable—and the data transferable—so fifty or a hundred years from now you won’t need access to maps from 

the time the specimen was collected to know where it lived.  Standardizing locations—as much as we can—to 

this type of system helps support the long term accessibility to these collections.  

 

Can’t a computer do this? 

Sort of.  If you’ve used the GEOLocate tool, you can see it can be surprisingly accurate when it suggests a 

location, but based on the description, it may pull up multiple possible locations.  Humans are still better at 

interpreting the context of the location description and (hopefully) narrowing down the collection site to a 

particular point on a map (with a smaller degree of uncertainty).  The software can get us most of the way there, 

but humans are still the best at refining and determining the accuracy of the program’s guesses. 

 

What if I only have a state? 

You don’t really need to bother georeferencing any specimen that doesn’t have anything more specific than a 

state or province.  Any location description much larger than a county (unless it’s a state park or other type of 

natural area) usually won’t need your attention—these we can do automatically.  Actually, GEOLocate will not 

produce a result if you only have State, Province, or Country data.  See page 17 for a complete list of 

circumstances where you shouldn’t georeference a specimen. 

 

Is an uncertainty circle ever not necessary? 

No.  Even if the site where the specimen was collected was located using the latest GPS equipment, there 

would still be uncertainty.  Current technology can narrow the uncertainty to a few meters (or even 

centimeters), but not remove uncertainty altogether. 
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Appendix B: Georeferencing Resources 
 

Please refer to these resources for more information about the GEOLocate program and georeferencing 

methods. 

 

 iDigBio GEOLocate Basics 

4 minute tutorial on the web version of GEOLocate (functions in EMu are the same): 

https://vimeo.com/showcase/2163673/video/65222791 

 Guide to Best Practices for Georeferencing.  

Includes glossary and a technical explanation of how to calculate uncertainty in most situations: 

http://herpnet.org/herpnet/documents/biogeomancerguide.pdf 

 

 Georeferencing: The Polygon Method 

How and when to use an error polygon:   

https://www.idigbio.org/sites/default/files/working-groups/gwg/GeoreferencingBlogPolygons_FINAL-

1.pdf 

 Georeferencing Quick Reference Guide 

A short glossary of georeferencing terms and very accessible instructions on how to set your uncertainty 

radius in most situations: http://www.herpnet.org/herpnet/documents/GeoreferencingQuickGuide.pdf 

 

 Public Land Survey System (PLSS) 

The PLSS gives us the town, range, section, & quarter (TRSQ). To understand how the PLSS units are 

designed: http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture04/concepts/ 

Map%20coordinate%20systems/Public%20Land%20Survey.htm 

 Tutorial on the Public Land Survey System Descriptions  

The Wisconsin DNR’s tutorial on the PLSS grid in Wisconsin: 

https://dnr.wi.gov/topic/forestmanagement/documents/plsstutorial.pdf 

 Wisconsin Township and Range Reference Map 

A brief explanation of township & range concepts and an excellent map of WI townships. 

https://wgnhs.wisc.edu/pubs/000915/ 

 

For alternate maps or for alternate search options for named places: 

 USGS GNIS Feature Search 

Search for named places and features. 

https://geonames.usgs.gov/apex/f?p=138:1:0::::: 

 

 Wisconsin Survey Control Finder (PLSS): 

Township/Range/County searchable. 

https://maps.sco.wisc.edu/surveycontrolfinder/#7/44.730/-90.143/PLSS/terrain 

 PLSS Map Viewer – ArcGIS:  

Searchable by place name. 

https://vimeo.com/showcase/2163673/video/65222791
http://herpnet.org/herpnet/documents/biogeomancerguide.pdf
https://www.idigbio.org/sites/default/files/working-groups/gwg/GeoreferencingBlogPolygons_FINAL-1.pdf
https://www.idigbio.org/sites/default/files/working-groups/gwg/GeoreferencingBlogPolygons_FINAL-1.pdf
http://www.herpnet.org/herpnet/documents/GeoreferencingQuickGuide.pdf
http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture04/concepts/%20Map%20coordinate%20systems/Public%20Land%20Survey.htm
http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture04/concepts/%20Map%20coordinate%20systems/Public%20Land%20Survey.htm
https://dnr.wi.gov/topic/forestmanagement/documents/plsstutorial.pdf
https://wgnhs.wisc.edu/pubs/000915/
https://geonames.usgs.gov/apex/f?p=138:1:0:::::
https://maps.sco.wisc.edu/surveycontrolfinder/#7/44.730/-90.143/PLSS/terrain
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https://www.arcgis.com/apps/View/index.html?appid=019dd6f39fda4d3b811abfab0878b63b 

 The US: https://viewer.nationalmap.gov/advanced-viewer/ 

 Mapcarta: https://mapcarta.com/ 

  

https://www.arcgis.com/apps/View/index.html?appid=019dd6f39fda4d3b811abfab0878b63b
https://viewer.nationalmap.gov/advanced-viewer/
https://mapcarta.com/
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Appendix C: Public Land Survey System Basics 
While you don’t need to understand the deep history of the Public Land Survey System (PLSS or USPLS) to 

create accurate error polygons from mapping coordinates in GEOLocate, it will help you find the appropriate 

sections on the map more quickly if you have a basic idea of how the grids are laid out.  For more in-depth 

discussions, please review the links provided on the previous page—or poke around online! There are many 

good sites describing the system in depth. Key things to know about PLSS: 

 

Established by Congress in 1785, this is a grid system designed to partition United States public lands into units 

for settlement.  It was done by teams of humans surveying large sections of land, which means: 

 It’s not a grid imposed on a map projection, but a reflection of lines measured on the ground. 

 It can be used to locate areas, but not specific points. 

 The descriptions, like SW1/4, NE1/4, Section 13, T4N, R2E, are legal descriptions of parcels of land. 

 

The map below shows the Principal Meridians (longitudinal north-south lines) and Baselines (the parallels or 

latitudinal east-west lines) for the surveys.  Each colored section represents a different region that was 

surveyed, each with a unique name for its principal meridian and its own Origin—the intersection of the 

section’s principal meridian and baseline.  

   

 

 

 

Fig 1. 1988 BLM map depicting the principle meridians and baselines used for surveying states (colored) in the Public 

Land Survey System.  The areas in white are not covered by the PLS system.  
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 Because the meridians and base lines were chosen for an 

entire area being surveyed, most states will not have even 

distributions of townships north or south of the baseline or 

east and west of the principal meridian.  For instance, the 

base line for townships in Wisconsin follows its southern 

border, and the principal meridian runs north-south in the 

western half of the state.   

 The units are numbered to the borders of the area 

surveyed; this can lead to labels for adjacent units seeming 

peculiar.  Illinois is a good example, as the NW townships 

from the 2nd Principal Meridian survey (circles) are adjacent 

to the NE townships from the 3rd Principal Meridian survey 

(rectangles), and the NW and NE units from the 3rd are 

adjacent to the SW and NE units from the 4th Principal 

Meridian survey (triangles).   

NW 

NE 

SW 
SE 

NE 

SW 

NW 

SW 

NE 

If we take a closer look, 

you can see that the 

Principal Meridians and 

the Base Lines for each 

region surveyed do not 

necessarily line up.  You 

can also see that the 

regions surveyed 

occasionally follow state 

borders, but may include 

sections from multiple 

states.  From the Origin, 

the surveyors would 

divide land into units 36 

square miles (6 miles by 

6 miles) in size, 

incrementing north, 

south, east, and west.  

These units are known 

as townships. 

Origin Points 

Note: Yes, the 4th 

Principal Meridian 

has two origins, 

established 16 years 

apart.  This is not 

typical. 
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In a lot of ways, the regions surveyed are a patchwork quilt—the numbering pattern of gridlines is consistent 

within each patch, but may not align precisely (or sensibly) with the next patch.  Let’s take a closer look at how 

these grids are laid out, starting with how you identify a unit: 

 

SW1/4, NE1/4, Section 13, T4N, R2E 

 

This would be read as “southwest quarter of the northeast quarter of section 28, township 4 north, range 2 

east” and works from the most detailed (smallest) part of the description out to the most general (largest).  

However, it’s a bit easier to do what you’re doing—interpreting the location of a particular unit—from the most 

general labels to the most specific, so we’ll start by discussing the Township and Range. 

 

As noted, from the origin in each of these regions, a grid is created of blocks measuring six miles on each side, 

known as townships.  They are identified by Township and Range labels.  The Township label indicates how 

many rows north or south of the baseline the unit is and run parallel to 

the baseline.  Range runs parallel to the principal meridian, so the Range 

label indicates which column the block is in east or west of the principal 

meridian.   

 

In the illustrations below, you can see a horizontal green line indicating 

units in the 32nd line north (32N) of the baseline, representing the 

Township.  The vertical blue line indicates units in the column 18 to the 

east (18 E) of the principal meridian.  The combination of T32N and 

R18E identifies a particular township or unit in the grid:  

 

 

 

                    
 

 

 

 In theory, every grid cell represents about 36 square miles, but precision is variable, given the challenges 

of terrain and the limitations of the instruments of the time used by the surveyors. Grid units should not 

be used to calculate precise distances. 

 Due to issues with laying grids on curved surfaces, the surveyors made corrections every 4th township & 

range line, so every 24 miles or so the townships are offset from each other. Occasionally, there chunks 

of land—particularly in the western U.S.—that got missed in error that may not be included in the survey, 

or if they are, are identified with half numbers (e.g. “T28.5N, R15”).   WI does not have any half sections.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2. Wisconsin Principal Meridian 

and Base line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.3.  
Range (R) 18 E Township (T) 32 N 

+ = 
T32N R18E 
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Each township is divided into 36 Sections, each a square mile (or less 

near borders).  The numbering system is consistent for all townships, 

even if survey boundaries or a geographical feature like a lake means   

the township has an irregular shape.  The numbers wrap around in an    

“s” pattern, starting in the upper left corner (a text style known as 

“boustrophedonic,”  literally “turning like the oxen plowing.”) 

 

 

 

 

   
 

     

 
T 4 N 

R 2 W 

 
T 4 N 
R 1 E 

T 4 N 
R 4 E 

T 4 N 
R 4 E 

  

 

 
T 3 N 
R 2 W 

 
T 3 N 
R 1 E 

T 3 N 
R 2 E 

T 3 N 
R 3 E 

T 3 N 
R 4 E 

  

 
T 2 N 
R 2 W 

 
T 2 N 
R 1 E 

T 1 N 
R 2 E 

T 1 N 
R 3 E 

T 1 N 
R 4 E 

  

 
T 1 N 
R 2 W 

 
T 1 N 
R 1 E 

T 1 N 
R 2 E 

T 1 N 
R 3 E 

T 1 N 
R 4 E 

  

  
T 1 S 
R 1 W 

  
T 1 S 
R 3 E 

T 1 S 
R 4 E 

  

 

 

 

Each section is further divided into 160 acre quarters, then 

each quarter is divided into 40 acre quarter-quarters, then the  

quarter-quarter is divided into 10 acre quarters, and so on (you  

will occasionally see specimen collection sites identified more 

precisely than the quarter-quarter to the quarter-quarter-quarter 

level). 

 

Specimens sometimes straddle two or more quarters.  In these 

cases, a collector may use “half” units (e.g., E1/2 NE ¼, 

 as seen in Fig. 4.)  On rare occasions you may also see the  

notation “C,” indicating “center,” written on labels as“C- NW ¼.”  

 

In EMu “Center” will appear in the Quarter field in the Sites 

module’s Mapping tab in a variety of ways: “N Center,”  

“Center,” “C,” etc. See the collection manager for assistance in  

interpreting the Mapping data if you find “Center” in another field. 

 

 

6 5 4 3 2 1 

7 8 9 10 11 12 

18 17 16 15 14 13 

19 20 21 22 23 24 

30 29 28 27 26 25 

31 32 33 34 35 36 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.  Subdivisions of sections. 
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Let’s discuss how to identify subsections of Sections by looking at our earlier example, SW1/4, NE1/4, Section 

13, T4N, R2E.  We start by identifying a specific unit of land within the township T4N, R2E: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SW1/4, NE1/4, Section 13, T4N, R2E:   

In EMu, quarter, quarter-quarter, etc data will appear in 

the same field (Quarter), which can intitially look 

confusing; “NW1/4SE1/4NW1/4” , “NW1/4SW1/4,” or 

“SENE,” which omits the “1/4” notation.   Remember 

that these are written from smallest detail to the 

largest, so “NW1/4SE1/4NW1/4” is the “northwest 

quarter of the southeast quarter of the northwest 

quarter” of a section.  Work from right to left to identify 

the correct quarter of the quarter-quarter section 

(below): 

NW1/4SE1/4NW1/4  

 

Some Quarters in EMu will have non-standard notation 

(e.g. only a “1,” “2,” “3” or “4,” or “W1/2-27 N1/2-33”).  

Please see your collection manager for assistance with 

interpreting these mapping details.  

 

 

 

 

 

 

 

6 5 4 3 2 
 

1 

7 8 9 10 11 12 

18 17 16 15 14 13 

19 20 21 22 23 24 

30 29 28 27 26 25 

31 32 33 34 35 36 

NW 1/4 
NE 1/4 

NE 1/4 
NE 1/4 

SW 1/4 
NE 1/4 

SE 1/4 
NE 1/4 

NW 1/4 NE 1/4 

SW 1/4 SE 1/4 

6 5 4 3 2 1 

7 8 9 10 11 12 

18 17 16 15 14 
NW 

NW NE 

SW SE 

SW SE 

19 20 21 22 23 24 

30 29 28 27 26 25 

31 32 33 34 35 36 

NW 1/4  
NW 1/4 

NE 1/4  
NW 1/4 

NE 1/4 NW1/4 
SW1/4 
NW1/4 

NE1/4 
SW1/4 
NW1/4 SE 1/4  

NW 1/4 SW1/4 
SW1/4 
NW1/4 

SE1/4 
SW1/4 
NW1/4 

SW 1/4 SE 1/4 

Section 13, T4N, R2E NE ¼ of Section 13 SW Quarter-Quarter 



Milwaukee Public Museum DRAFT April 2020  
41 

When looking at maps, remember how sections are numbered to spot the borders between townships: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If we apply this to GEOLocate in EMu, we start with the PLSS details, which appear on the Mapping tab: 
 

 
 

 

GEOLocate will 

generate results based 

on the Locality String; 

a quick Google search 

confirms that Kohler 

Park Dunes State 

Natural Area is a part 

of the Kohler-Andrae 

State Park. Next, you 

should confirm the 

park is in township 

T14N, R23E, by 

looking for the 

township and range on 

the map 

 

6 5 4 3 2 1 6 5 4 3 2 1 

7 8 9 10 11 12 7 8 9 10 11 12 

18 17 16 15 14 13 18 17 16 15 14 13 

19 20 21 22 23 24 19 20 21 22 23 24 

30 29 28 27 26 25 30 29 28 27 26 25 

31 32 33 34 35 36 31 
 

32 33 34 35 36 

6 5 4 3 2 1 6 5 4 3 2 1 

7 8 9 10 11 12 7 8 9 10 11 12 

18 17 16 15 14 13 18 17 16 15 14 13 

19 20 21 22 23 24 19 20 21 22 23 24 

30 29 28 27 26 25 30 29 28 27 26 25 

31 32 33 34 35 36 31 32 33 34 35 36 

Since Townships 

run east-west, you’ll 

find them on the 

border that runs 

east-west between 

townships.  We can 

confirm the locality 

is in T14N. 

In GEOLocate, the ESRI 

USGS Topo USA maps have 

the PLSS townships and 

sections marked, although 

how much you see depends 

on your zoom.  At 1000m, 

you will see the Township 

and Range boundaries 

marked, plus the corner 

sections for each township 

(1, 6, 31, 36).  At 500m, you 

should see all the sections 

labeled. 
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Next you’ll want to confirm that the Kohler Park Dunes State Natural Area is in R23E: 

 
 

 

 

 
 

If you’re comfortable toggling between EMu and maps on the internet, the Survey Control Finder for Wisconsin 

or the ArcGIS PLSS Map Viewer are a quick way to cross check Township, Range, and Section details.  You will, 

however, still need to find the necessary points on the GEOLocate map to create a polygon if your project or 

the site details require it. 

The ranges tend to 

be printed along the 

edge of the top of 

the state (or at 

borders between 

surveys), so you may 

have to follow the 

line quite a ways to 

find the Range 

marked. 

 

If you recall how 

sections are 

numbered within 

townships, you can 

spot the border 

corners here.  The 

range numbers will 

appear along the line 

that runs north-south 

between them. 


  R

A
N

G
E

  
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With your zoom at 500m, you can see all the section borders (red and white lines) and number labels (red 

numbers near the center of the squares).  We need Section 23: 

 

 
 

 

 

Since the mapping details show us that we’re looking for the NW1/4, Section 23, T14N, R23E, we need to 

draw a polygon that only includes the northwest corner of the section: 

 

 

 

 

 

 

 

 

 

 

 

Due to either the map 

projection or survey errors, 

the lines on the map may 

not be precisely straight—

follow the borders as well as 

you can.   For townships 

along borders the sections 

may be irregularly shaped.  It 

can be useful to look at an 

adjacent section to judge 

where to create the borders 

for your polygon so that it 

includes the quarter section 

you need.    

Terry Andre is one of two adjacent 

state parks managed as one unit under 

the name “Kohlar-Andre State Park.” 

Red and white lines are paved roads—these 

frequently follow section lines.  When the 

roads curve away you can spot faint red 

lines—these are Section border lines. 
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Once you’ve drawn your polygon, since there is no other locality string data guiding where you set the marker, 

place it at the geographic center of the polygon. Then reset the uncertainty to the polygon and save your 

location to the application.  Continue to the Lat/Long tab to complete the georeference details. 

 

 

Note: If the Locality string provides enough detail to narrow the uncertainty even further, you do not need to 

polygon the section quarter—simply confirm that the marker you’ve placed would fall in the section or quarter 

noted, and then plot the uncertainty as appropriate for the feature. If you have questions about how to 

interpret a Locality description in the context of the PLSS details in the Mapping tab, please see the collection 

manager for help. 

 

Image credits: 

Fig.1: United States Geological Survey. https://nationalmap.gov/small_scale/a_plss.html. (Public Domain.) 

Fig. 2: Lippelt, I. D. “Wisconsin township and range reference map.” Wisconsin Geological and Natural History Survey. 

https://wgnhs.wisc.edu/pubs/000915/ 

Fig. 3: Wisconsin Department of Natural Resources. “Tutorial on the Public Land Survey System Descriptions.” 

https://dnr.wi.gov/topic/forestmanagement/documents/plsstutorial.pdf 

 

Fig 4: Albrecht, Jochen. “Public Land Survey System.” http://www.geography.hunter.cuny.edu/~jochen/ 

GTECH361/lectures/lecture04/concepts/Map%20coordinate%20systems/Public%20Land%20Survey.htm 
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Glossary 
Accuracy* — a measure of how well data represent true values. 

 

Datum* — a parameter or set of parameters that serve as a reference or basis for the calculation of other 

parameters [ISO 19111]. A datum defines the position of the origin, the scale, and the orientation of the axes of 

a coordinate system. A datum may be a geodetic datum, a vertical datum or an engineering datum. In this 

document, the term datum generally refers to a geodetic datum. 

 

Error Polygon—in geometry, a polygon is a shape described by a finite series of straight sides.  When 

georeferencing, this can be a shape generated by your software, usually defining the boundaries of a named 

place like a town, park, or natural area.  In GEOLocate, you may also draw a polygon to define an area—this is 

known as the error polygon.   

 

Extent*— the geographic range, magnitude, or distance which a location may actually represent. With a town, 

the extent is the polygon that encompasses the area inside the town’s boundaries. In this document, we usually 

refer to the linear extent – the distance from the geographic center of the location to the furthest point in the 

representation of the location. 

 

Feature* — a natural or anthropogenic object or observation that can be represented spatially. The term 

“feature” may refer to categories of objects or feature types (e.g., mountains, roads, or cities) or to specific 

feature instances (e.g., Mount Everest, Interstate 25, or San Francisco), which are also sometimes referred to as 

“named places.”  

 

Feature Name* — a proper name applied to a feature; the name of a named place.  

 

Footprint* — a spatial representation of a feature as an area. The extent and shape of a footprint may comprise 

the actual boundaries of a feature, the uncertainty around a point representation of a feature, or some 

combination of an estimate of the boundaries of a feature and the uncertainty associated with those 

boundaries. 

 

Geodetic—(adjective) pertaining to geodesy, which is the science of measurement of the earth. 

 

Geodetic datum* —a model of the earth used for geodetic calculations. A geodetic datum describes the size, 

shape, origin, and orientation of a coordinate system for mapping the surface of the earth (NAD27, SAD69, 

WGS84, etc.). Geodetic datums are often recorded on maps and in gazetteers, and can be specifically set for 

most GPS devices so the waypoints match the chosen datum.  

 

Geographic center* — the geographic center of a shape is the mean of the extremes of latitude and longitude of 

that shape. If the result is not within the shape itself, choose instead the point in the shape nearest to the 

calculated geographic center. 

 

GEOLocate—software developed to assist in georeferencing specimen collection sites.  It works by breaking 

apart the locality string into common terms and parses out distances, compass directions, and key geographic 

identifiers (i.e. place names, highway/waterway crossings, distances, etc), using this information to determine a 

series of possible geographic coordinates.  GEOLocate is accessible as an online program, can be downloaded as 
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a standalone program, or is an application within database programs like EMu, Specify, or Symbiota. (This is why 

sometimes you will hear GEOLocate mentioned as a part of EMu and as its own thing—it’s both.)  For more details, 

visit: https://www.geo-locate.org/about.html  

 

Georeference* — to translate a locality description into a mappable representation of a feature (verb); or the 

product of such a translation (noun). 

 

Locality String/Locality Description—verbal description of where a specimen was collected.  Strings can vary 

from short and relatively non-specific, like “Rock Island State Park” or “Douglas County,” to somewhat longer 

and more specific, such as “Lake Superior beach at the end of Moccasin Mike Road, near Wisconsin Point near 

Superior,” or “Parkway where Honey Creek joins the Menomonee River, near North 72nd Street north of West 

Wisconsin Avenue.”  If the information has been ingested into EMu, the original verbatim label information will 

have been parsed into appropriate fields (state, county, municipality, township/range, etc).  GEOLocate can 

parse the full string and provide results based on part or combinations of pieces of information in the string.  

 

Named place* — used to refer not only to traditional features (q.v.), but also to places that may not have proper 

names, such as road junctions, stream confluences, highway mile pegs, and cells in grid systems (e.g., 

townships). 

 

Offset* — a displacement from a reference point, named place, or other feature. Used here as the distance from 

a named place using the location of the named place as the starting point. Usually used in conjunction with 

heading to give a distance and direction from a named place. 

 

Path— a locality that is a linear feature, e.g. a road, trail, boundary, river, or contour line. 

 

Point-Radius—a georeferencing method where the most probable point of collection forms the center of a 

circle with a radius that describes the extent of the feature (named or otherwise) or other possible collection 

sites described by the locality information.   

 

Uncertainty* —a “measure of the incompleteness of one’s knowledge or information about an unknown 

quantity whose true value could be established if a perfect measuring device were available” (Cullen & Frey 

1999). Uncertainty is a property of the observer’s understanding of the data. 

 

Uncertainty Circle—when using a GPS, uncertainty is a measure of how accurate the unit is for calculating the 

actual site location. In georeferencing, it indicates how sure you are of point on the map, which should always 

contain all of the areas that could be where the specimen was collected (e.g., a specimen with a label that just says 

“Milwaukee” would include all of Milwaukee; a specimen with a location of 800 block of West Wells would have an 

uncertainty that includes the whole block).  Generally uncertainty is expressed as a circle; the center is place over 

the most likely point where the specimen was collected.  Related terms include the radius or area of uncertainty; 

a two mile radius from the center point would create an uncertainty area of over 12 miles surrounding the 

central point.   

 

WGS84 (World Geodetic System 1984) * — a coordinate reference system in common use globally to fit the 

shape of the entire Earth as accurately as possible using a single ellipsoid. Other ellipsoids (datums) are 

commonly used locally to provide a better fit to the Earth in a local region. 

 

* Glossary terms from “Guide to Best Practices for Georeferencing.”  See Bibliography for full citation. 

https://www.geo-locate.org/about.html
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GEOLocate Quick Start Checklist and Tables 

 
Welcome back to georeferencing! If you only need a reminder on the steps to georeference a site, below is a 

brief checklist.  Refer to GEOLocate Features (pg. 5) for more details on the tools in the tab, and GEOLocate: A 

Guide to Georeferencing (pg. 11) for screen shots and more detailed instructions on how to georeference sites. 

 

 

 When you’ve opened EMu, go to the Sites module. 

 In Sites, open your list of sites (Tools>Retrieve) to georeference and sort the list (View >Choose> 

IRN Summary Data Mapping (or whatever sort you prefer)). 

 Select the first site to georeference; if it has PLSS mapping data, note it down or go to the Mapping 

tab and record the TRSQ details. 

 Go to the GEOLocate tab.  Review the results. 

 Refine the results; if there is PLSS unit data, redraw the polygon if useful.  You may remove the 

polygon if it is not necessary for your site. 

 Make sure the uncertainty circle is sized appropriately. 

 When you have the location and uncertainty circle placed, click Save to Your Application. 

 Go to the Lat/Long tab.  Fill in the following information: 

 Determination Source: GEOLocate 

 Determination Method: Caywood, A. et al. 2020. GEOLocate 101: A 

tutorial. Milwaukee Public Museum. 51 pp. 

 Determined By: Your Name 

 Date: Today’s Date (short cut: “Ctrl ;”) 

 Datum:  WGS84 

 Preferred: Yes 

 Units: Meters 

 (For subsequent records, use F9 to duplicate the fields.) 

 If necessary, add details about your decision on the Notes-Attrib tab. 

 When complete, Save the record. 

 Continue georeferencing until your session is complete. 

 Exit EMu. 

 Log off or shut down your computer. 
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Common Georeferencing Circumstances 

Situation Finding the Point Extent  Notes 

Named Place 
w/Defined Area 
(e.g. “Milwaukee,” 
“Lake Minnetonka,” 
“Isle Royale,” etc) 

Look at the boundaries of 
the area; GEOLocate will 
usually create a polygon 
around the borders and 
place the point in the 
geographic center of the 
space, or the nearest point 
within the borders. 

The radius should extend far 
enough that the entire circle 
contains all borders for the 
feature. 

If GEOLocate does not 
generate a polygon on 
the borders of the 
feature, use the maps 
to determine as best 
you can the boundaries 
of the place. 

Named Place w/ 
Undefined Area 
(e.g. “Walbecker 
Bog,”  “Cuidad 
Victoria and 
vicinity”) 

As near the center of 
named place as can be 
determined using a map. 

Radius = ½ the distance between 
the point and the nearest named 
place (as the crow flies.) 

 

Street Address You will probably have to 
use Google Earth. Put the 
point in the middle of the 
property, as near as you 
can figure. 

Make the radius as big as you can 
ascertain the property to be. 

These should always be 
checked; GEOLocate 
tends to put them in 
the middle of the lake. * 

Distance from a 
city (ordinal 
direction) 
E.g. 5km south of 
Eagle 

Measure 5 km from the 
center of the named place.  

Radius = ½ of the distance 
between the point you placed and 
the nearest named place. If the 
nearest named place is Eagle, the 
radius would be half of 5km; 2.5 
km or 2500m. If another named 
place was nearer than Eagle, you 
would use that named place. 

Exception: if the string 
includes a second 
named place, like “Pike 
Lake 5km south of 
Eagle.” (see Named 
Place)  

Distance Along 
Road 
(e.g. Route 95, 5 km 
S of Townsville) 

Put the point at the 
measured distance along 
the road. 

Radius= ½ the distance between 
the point and the place named in 
the point. 

 

Path/Linear 
Feature (e.g. road, 
river, contour, trail) 

Point should be placed 
halfway between the 
beginning and end of the 
path, or if only a section of 
the whole is named, the 
halfway point of that 
section. 

Extent should include the whole or 
the section of the feature noted in 
the description. 

 

 

*If you find GEOLocate is erroneously placing terrestrial points in the center of water bodies, try unchecking 

Match Water Body in Options (see page 5 for more about the Data Pane’s Georeferencing options) and click 

Georeference to generate a new set of results (this box will remain unchecked until you check it again).  

 

If after reviewing the table and the Georeferencing Quick Reference Guide you aren’t sure how to set the 

uncertainty circle, see the Collection or Digitization Manager for help. 
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Quick Access tables for required fields and data standards in the Sites Module: 

Sites Lat/Long Tab Required Fields 

Emu Field Value Type of field 

Determination Source GEOLocate Autofill 

Determination Method Caywood, A. et al. 2020. GEOLocate 101: A 
tutorial. Milwaukee Public Museum. 51 pp. 

Autofill 

Determined By Your Name Type it in! 

Date Today’s date Either CTRL+ ; OR use the calendar  

Datum WGS84 Autofill 

Preferred Yes Drop down list 

Units Meters Autofill 
 

Sites Attributed Notes (Notes-Attrib) Required Fields 

Emu Field Value Type of field 

Note Details should be in sentence format with appropriate punctuation.  Clearly 
describe any inferences you made, additional resources you used, or why 
you were unable to georeference the site. (See next table for standard Note 
comments.) 

Text field.  

Kind Mapping Remarks Look up list 

Attributed To Your Name Type it in! 

Date Today’s date Either CTRL+ ; OR 
use the calendar  

Metadata Yes Radio Button 
 

Sites Attributed Notes (Notes-Attrib) Data Standards 

Note Reason Sentence Format 

Inference Made Inference made regarding site locality; *describe what you’ve assumed and why.+ 

Cannot Verify Precise 
Locality 

Could not determine precise locality. Georeference based on “*coordinates+.”  
[Provide any details that may be helpful for future research.] 

Additional Resources Used Additional resources used to georeference site: [list resources.] 

Dubious Site Locality Dubious locality description; could not georeference site. 

Inaccurate/ Conflicting Site 
Locality 

Inaccurate/ conflicting locality description; could not georeference site. [Follow 
with explanation of conflict or inaccuracy.] 

Nonspecific Locality Locality description is not specific enough to georeference site.  [You do not need 
to add a Note for states, provinces, or countries.]   

Unable to Determine Unable to determine location; may require further research.  [Provide any details 
that may be helpful for future research.] 

 


